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2015 GENERAL MEETINGS CALENDAR

FROM YOUR PRESIDENT

May we all have a nice
Vernal Equinox & St. Patrick’s Day!

Norbert (Bob) Gostischa will speak Tuesday 3-

17-2015: AVAST anti-spyware & antivirus. He is

excellent.
NEW MEMBERS IDEAS - HOW TO GET THEM!!

Sept 2014: was Michael’s last column as editor.
Needed: an editor or publisher!! Contact me!!

At the meetings, we’ll have a free flowing discussion
showing various web sites, do Q&A and give the best
advice we can.

I will try Microsoft Windows Speech Recognition. Bring

your laptop and a microphone if you would like to try it
yourself. (I know, we’ve missed this before).

Want lots of tech news? Then go to news.google.com -
then choose technology: http:/tinyurl.com/kru237d

Kim Komando & tips this month:
https://www.google.com/?gws_rd=ssl#qg=kim+komando

Ken Coburn, Data Doctors Tech Tips
http://www.datadoctors.com/media/tips/

Leo Laporte http://www.techguylabs.com/
http:/leoville.com/ http://twit.tv/people/leo-laporte

June 2014, I tried out Norton Safe Web
http://safeweb.norton.com & Online Link Scan -
www.onlinelinkscan.com Both are excellent. One
member emailed me about protecting his PC, both
excellent ways to avoid malware, ransom ware, etc.

Free Internet watchdog warns you about bad sites

http://www.komando.com/downloads/759/free-internet-
watchdog-warns-you-about-bad-sites/all

If any email looks suspicious - DON’T OPEN IT! Email
sender if it‘s a friend. Might be a spoof - a fake.
http://en.wikipedia.org/wiki/Spoofing_attack

How to “avoid ransom ware“? - Google this!!

The Kim Komando Show - all stations and times -
Tuneln, just Google “komando tunein all stations”

It’s on various stations and times. Listen free over the
Internet on weekends.
http://www.komando.com/downloads/2321/6-
essential-types-of-security-software-you-must-have/all

Komando Indoor Pan Tilt Wireless Security Camera,
http://shop.komando.com/kim-komando-pan-tilt-
security-camera

Warning: New virus targets smartphones
http://www.komando.com/happening-now/276431/?
utm_medium=nl&utm_source=notd&utm content=20
14-10-10-article_2-title/all

http://www.komando.com/tips/275213/essential-
security-software-for-your-tablet-and-phone/all

7 essential steps to secure your smartphone or tablet

http://www.komando.com/tips/12475/7-essential-
steps-to-secure-your-smartphone-or-tablet/all

Technology news: http://tinyurl.com/ppvgoa3

Lots of CES 2015: http://tinyurl.com/nheghzj
Robots Take Over Las Vegas:
http://abcnews.go.com/Technology/ces-2015-robots-
las-vegas/story?id=28083034

CNET Surprise! Microsoft jumps to Windows 10 -
http://www.cnet.com/news/is-this-why-microsoft-named-it-
windows-10/ Windows 10: Nine things you need to know
www.cnet.com/how-to/windows-10-what-you-need-to-
know

BRING A FRIEND!! WE STILL NEED NEW
MEMBERS!!

PDavid Yamasmoto-
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PRESENTATION THIS MONTH

WEST SIDE: CollegeAmerica (see map page 18)

- Tuesday, March 17, 2015

- 6:00 PM - Steering Committee and (Election of Officers - Nov & Dec)
- 6:30 PM - Questions and Answers

EAST SIDE: University of Advancing Technology (see map pg 18)
- Wednesday, March 18, 2015
- 6:30 PM - Questions and Answers

FOUNTAIN HILLS: Fountain Hills Libra

- Thursday, March 19, 2015
- 6:30 PM - Questions and Answers

see ma

age 18)

Meetings this year 2015: Reserve UAT for Jan - Mar 2015

Jan 20,21,22 Feb 17,18,19 Mar 17,18,19 Apr 14,15,16 May 19,20,21 Jun 16,17,18

Jul 14,15,16 Augl8,19,20 Sep 15,16,17 Oct 20,21,22 Nov 17,18,19 Dec 15,16,17
All meetings based on the 3" Wednesday of each month

REMEMBER: PAY YOUR DUES! Thanks. $36 / year or $3 / month
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My Office for iPad, Author: Paul McFedries

Review by Mary Ruth Butler, Member, Let's Compute, CA

Publisher: Que Publishing, Rating: Excellent

Level of information: Intermediate

Introduction: This review covers "My Office for iPad" from an intermediate user’s viewpoint. | have
used books written by Paul McFedries before; | found this book to be up to the standards | have come
to expect from McFedries. The book is well organized and the instructions are easy to follow. |
especially liked the color coding used for the illustrations.

The book follows a very logical pattern in discussing the various apps and includes an excellent
discussion of Office 365. One criticism | have, which is a minor one, is that | think the author should
have included more discussion on use of the apps for viewing only.

That point notwithstanding, | think the book offers the reader a thorough discussion on the use of the
various apps so that the reader can take maximum advantage of Office 365 on the iPad. The
explanations cover virtually all of the tasks that the reader would likely want to accomplish on the
iPad.

The individual sections on each of the apps are in enough detail to permit the reader to achieve
excellent command of each one. The "It's Not All Good" notes are very helpful in pointing out some of
the limitations of Office 365.

| was pleased that McFedries included a section on the use of OneDrive. This application is an
excellent tool for both PC and Mac users. | especially liked the information on sharing OneDrive
documents including the capability to use an extra level of security by requiring the recipient to log in
with using a Microsoft account.

Perhaps the most surprising feature of the book is the Excel Worksheet Function Reference section.
Although | am a confirmed Excel user, the Excel reference section offers a very easy way to expand
the use of Excel. This section will be helpful in using Excel in the full Office Suite on my PC as well as
on the iPad. The completeness of the book’s index is worth noting. | found it to be easy to use and
very complete.

| would definitely recommend that anyone who is interested in using Office 365 on an iPad buy the
book.

http://www.amazon.com/My-Office-iPad-Paul-McFedries/dp/0789748738

M

Ofﬁze for iPad
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Search Options — Windows 8.1

By Rosita Herrick, Director, Sarasota Technology Users Group, FL

October 2014 issue, Sarasota Technology Monitor

www.thestug.org, Rosita (at) spcug.org

In one of my more energetic phases, | decided to clean up my desktop hard drive last weekend.

| went to the File Explorer search box and looked of the option to search file by Date Modified and
could not find it.

After a little research, | realized that the many search options in File Explorer are alive and well if you
know how to look for them. And so | decided to post my finding in this corner to save you some
frustrations.

First click on the File Explorer icon on your desktops status bar.
By the way, notice that with the April update to 8.1 you can place App icons on the task bar.

D & a =5

Once the File Explorer page opens, click on the folder or the group you want to search.

| clicked on the Libraries item and the on the search box

v | ¢ | Search Libraries »p

s EAXvD e

Now, if you look at you screen, on the left side you will see a new tab called Search Tools

Search Tools

Home Share View Search

M- =

Click on this tab to expand it, and you will see the available options

k Current folder E:j Kind - ¥F) Recent searches ~ | %
- , All subfolders D Size v |:=|] Advanced options ~ o
This Date Open file  Close

pc = Search again in modified = D Other properties - |ml Save search location  search

Location Refine Options

To show an example here, | clicked on the Date modified item.

And then selected Today
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ET, T Kind -

Size ~
Date
modified | | Other

Today

Yesterday v (¢ | ptemodifieditoday| X

his week -
This wee d{) ) m x :

-l
Last week

Date modified Type Size Folder path
This month

8/19/2014 11:12 A, Microsoft Word Document 13 KB C\Users\Rosita\Documents\@2014\Misc
Last month

This year

Last year

And there is the file that was found (above):

As | was composing this article, | thought that it sounded like a lot of trouble. However, once you get
used to the steps, it is quite fast

1. Click on File Explorer Icon

2. Click on folder you want to search or on Computer if you want to search the entire C: drive.
3. Click on the Search Tab

4. Click on the selected search criteria

This type of search is quite handy if you just saved a file and don’t remember where you saved it or
forgot to name the document. | intend to use it to group all the documents that have not been
modified in two years and back them up on an external drive to remove some of the clutter in my
Document file.

NET NEUTRALITY
5 Things You Need to Know About the FCC's Net Neutrality Plan
http://www.pcmag.com/article2/0,2817,2476350,00.asp

FCC Chairman Hits Back at Net Neutrality Critics
http://www.pcmag.com/article2/0,2817,2477733,00.asp

Republican lawmakers question FCC budget after net neutrality vote
http://www.pcworld.com/article/2893132/republican-lawmakers-question-fcc-budget-after-net-
neutrality-vote.html

The FCC voted to preserve Net Neutrality https://www.battleforthenet.com/

Republicans’ “Internet Freedom Act” would wipe out net neutrality
http://arstechnica.com/business/2015/03/republicans-internet-freedom-act-would-wipe-out-net-
neutrality/
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Using Section Breaks in Short Word Documents

March 2015

Nancy DeMarte, 1st Vice President, Sarasota Technical User Group, FL

October 2014 issue, Sarasota Technology Monitor

www.thestug.org ndemarte (at) Verizon.net

Last month we examined the Page Break tools in MS Word. This
month we'll explore how to use the Section Break tools. Many
home Word users ignore these tools because they think they only
apply to very long documents. But section breaks can help you
format a short document, even a single page, in special ways.
We'll look at two uses of section breaks in short decuments: 1.
combining full page text with text in columns on one page and 2.
creating different headers, footers and margins in a document
with two or more pages.

What are Section Breaks?

Section breaks are similar to page breaks in that they divide
parts of a document; they differ in that you can have several
sections on one page, if needed, and can format each section
differently.

Section Break Styles:

look like this:

There are four styles of
section breaks. They

Section Breaks

=]

Next Page

appear in the Breaks ]
Insert a section break and start the new

—

gclllery on the P(Ig& | ] section on the next page.

Layout tab, Page Setup

group in Word 2007 or ~  Continuous

ICITE!’ e(JiiiOﬁS GF'ld on The Insert a section break an start the new
] 5 section on the same page.

Insert menu in earlier

editions. The first one, |=2=| [venPage

Next Page, inserts a Insert a section break and start the new

new section on the next
page. This is useful, for

0dd Page
=T Insert a section break and start the new

example, if you have a |
| section on the next odd-numbered page.

title page where you

through headphones while at the zym, Thave used my iPod Touchto surfthe-
Internet, read my-email from my-Verizon-and Yahoo-acoounts check my-stocks,
store-and view my digital photos, -and-play-a variety of interesting-and brain-
boosting games, all witheutspending-a-penny-bevond the purchase price-of the -

iPod Touch. soSection Brezk (CoiMinuous ..

The PC is needed torecharge the iPod,
to- dewnload- and- install- your- iTumes
application from- www.iTunes.com,
and-ro-visit-the comprehensive iTunes
srore, where: you- com- downicad fiee
and- paid- lirtle: applications- (called
“apps ) for your-iPod Touch. - f]

L
The-1Pod-Teuch comes loaded -with-several basic-apphcations, cludmg -the-Safan-
web browser, Mal, -a-photo-gallery,-a notepad. calculator, stocks, and-weather.-But-
that's-only the begimnmng. -At-last-check there-were-over-80,000-free-applications-
available-m-vanous-categones-at-1Tunes. such-as-utilities, news, sports, and-pames.-

How-could I-do-afl-those-activities-on:
somethingwhichweighs-only-4 ources:
arid has-a 3.5 inch-screen? First,-let s
Ipak-ar-what-ir required: fo- make-the-
iPod Touch perform. a Macor PCwith-
i XP-SP2-or-higher-operating system
anid- a- 2.0- USB- port,- ar free: account:

with iTunes, and-a Wi-Fi-connection. ) A s p
=z on Break {Conbinuaus}zzzzzizzee:

section on the next even-numbered page.

don’t want the header Figure 1 - the Section Breaks gallery

or footer that appears

in the rest of the pages.

The next style, Continuous, inserts a section break on the current
page, as in my example in Figure 2. The last two options, Even
Page or Odd Page, insert section breaks which begin on the next
even or odd page. This might be desirable with a chapter book,
where each chapter needs to begin on the right hand page.

Inserting and Deleting Section Breaks:

Inserting and deleting a section break is done the same way as
a page break. Insert a break by clicking in the spot where you
want the breok to occur, and then click the type of break you
want. Delete a break by dragging over the break indicator in
the document and then pressing the Delete key. If you have
trouble selecting the break indicator, try dragging slightly
diagonally down as you drag across the entire dotted line.

Project 1: Putting columns on the same page as full page text
Figure 1 illustrates a use of section breaks where you create o
page of text that is both full page width and in columns. It might

Figure 2 - Page with columns and full page text

In this example from an old article of mine, | added two section
breaks in order to emphasize a central paragraph by making it
two columns. First, | typed the entire document. This is always a
good idea with Word documents = draft the content of a
document all at ence to let the ideas flow, then apply formatting,
making changes as needed. Next | turned on the Show /Hide
tool, found on the Home tab in the top right corner of the
Paragraph group. Having this tool turned on lets me see where
the section break indicators are located, which is important in
case | need to delete or move one. My next step was to dlick at
the end of the paragraph which would stay full page width and
add a continuous section break, as described above. | repeated
that procedure to add another continuous section break at the
end of the paragraph | planned to format in columns. Finally, |
clicked inside the text between the section breaks and clicked

the Page Layout tab = Columns — Two to create two columns. This
use of section breaks works well for newsletters, toa, where you
have a banner headline across the page with columned articles
below.

Project 2: Different Headers and Margins in the same
document

Sometimes you have two or more pages in the same document
which you need to format differently, such as a title page and
body of a document. Using section breaks lets you add different
foaters or headers, margins and other formatting. In this project
(Figure 3) the first page is a short article on Desserts written by
a fictional food expert, Henrietta. The next page is the first of a
number of recipes related to the article. Notice that the first
page has a header; the second page does not. Both pages have
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the same footer, but the page two margins are wider than those on page one. This was all done using section breaks.

o
m

Should You-Give -Up-Dessert 9

Searu M s e era e T s f g el as s mag Faariy T 5 ¢-I.‘-"|.F—+l T
g fealfi Aot medhar p o shoa’d T oneid s Aoetr -8 wpacial a8y ser b ST
v eempiurs BE Vre i B TR YRR i T

e 7 I L e W L Teile BN WA W AR B A W TRAT TR
. ke TN LM S S HSAL IR PSS, Ty

R T

o, ot e o g A wagu

g o susmn o ged oAk S T han T o 1 TS
= Thare s nafeng borme dhae Sk v o v :m-u chchaa
srursssmse A7 IR TRERTTAI TREW BT Wiy SIaT Ml Sam S
R e

(RS Yt R Mt

T 5 S T AN TSR A RN RET Ty n-n:nq S bk HlaE i EAALL
NS TSR LR S 8T, TSR E O TAVERL W I T e S TSR S T A SR TS

-y megeean henenpages sz Gactio n Break {Hext Page):

& Pear-Blueherry Chap
.

First | typed the entire two pages, paying no attention to format, and turned on the Show/Hide tool. | added a header

(Insert tab — Header) and typed the author’s name and address, which appeared on both pages. Then | clicked at the end

of the page one article and inserted a Section Break — Next Page, as described above. To get rid of the header on page

two, | had to break the link between the pages. | clicked a random spot in page two and clicked the Insert tab — Header —

Edit Header. Then | clicked inside the header and, on the Header & Footer Tools tab, which only appeared when | was in

the header, clicked “Link to Previous” to remove the link between the two pages. Finally, | selected the header text on page
two and deleted it, leaving the header intact on page one.

Notes and Tips:

1. When you delete a section break, you may get an unexpected result if you don’t understand how section breaks work. A
section break controls formatting of the text before it. Therefore, when you delete a section break, the formatting from the
section just after that section will be applied to the section before the now-deleted break. If this is not what you want, click

the Undo button to restore the break and rethink what look you really want. It helps to plan out any multi-page document
which has sections so that you can insert the correct style of break in the right spot.

2. A Section Break — Next Page and a Page Break might seem to be the same, but only the section break will allow you to

have different formatting in different sections.
3. When adding section breaks, save your work (Ctrl+S) more often than Word does, which is about every 10 minutes.

4. Stretch your skills and try one of these projects with section breaks.

The Tip Corner — October 2014

By Bill Sheff, Lehigh Valley Computer Group, Pennsylvania

October 2014 issue, The LVCG Journal
www.lvcg.org
nsheff (at) aol.com

Let’s take a look at folders
When you highlight a folder and click on Organize you open a wealth of options. You can cut, copy, paste,

rename, delete and a few other goodies. In this column we will take a look at the “Folder and Search options”.

When you click on the Folders and Search options another Pane opens up showing three tabs: General,
View and Search with the General tab highlighted.
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The first choice is Browse folders where you can Open a folder in the same window or open each folder in its
own window.

If you click Open each folder in its own folder window this will keep all open folders that you're working with on
the screen at the same time. The other option makes each newly opened folder replace the previous one.

While opening every folder in a separate window (and memory) will Increase the stability of Windows this could
slow your computers performance. | would suggest only using this setting if your computer frequently stops
working and you want to minimize or troubleshoot problems.

Clicking: Opening files and folders with a single click allows you to use the same procedure that you use when
going to a link on a webpage. Recommend keeping the standard double click to open items (and single-click to
select).

For the navigation pane | guess that is up to you. I like just having the main folder open and | can then open
any sub folder | want to get to.

Once you have made you choices you can click OK or Apply and your settings are now in use. Try them out.
Remember you can click “Restore Defaults” to bring them back to the original settings.

Moving over to the Search tab, | usually just keep the defaults. One comment though is indexing. | think the
jury is still out on that. On one hand the searches are conducted much faster, on the other, indexing can slow
down your computer. If you do not do a lot of searching | would suggest not indexing your drives. (Certain
folders are indexed by default. To see what is being indexed on your computer, or to change what is being
indexed go to control panel>Indexing Options.)

The most comprehensive tab is the View tab. Here you can do a lot of modifying to get your view exactly the
way you want it. In most cases the choices you make are based upon some personal preference; however
there are some considerations that should be made as you make up your mind. | have an X before the choices
| have selected.

Some are the default selections and some are what | wanted. To pick what you want put the mouse in the
shaded box or circle and click. Clicking again removes the check.

Some of the things you can do and what | have selected (with an X) are:

X Always show icons, never thumbnails (Use this setting if thumbnail previews are slowing down your
computer.)

Always show menus (Use this setting if you want access to the classic menus, which are hidden by default.)
X Display the icon on thumbnails ((for easier access to the related program)
X Display file size information in folder tips
Display the full path in the title bar
Hidden files and folders (Unless you have to work with windows files you don’t need to show them.)

X Don’t show hidden files, folders or drives
Show hidden files, folders and drives

X Hide empty drives in the Computer folder (This option doesn’t affect empty floppy disk drives, CD drives, or
DVD drives.)

Hide extensions for known file types (Windows by default has this checked, but you should uncheck it since
this is a good way to ensure that files are not malicious software disguised as common files.)
X Hide protected operating system files (This is recommended)

Launch folder windows in a separate process

Restore previous folder windows at logon (Automatically open the folders that you were using when you last
shut down Windows whenever you start your computer. This helps preserve your work from session to
session. But if you do many different things you may not want to check it.)
X Show drive letters (Use this setting if you prefer to see only the friendly name of each drive.
X Show encrypted or compressed NTFS files in color (Use this setting if you don't want to see these files
represented differently than other files on your computer.)
X Show pop-up description for folder and desktop items
X Show Preview handlers in preview pane (If you don’t want to show the contents of files in the preview pane
leave it unchecked. Some believe that this setting could improve the performance of your computer.)
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Use check boxes to select items (This can be useful if it's difficult for you to hold down the Ctrl key while
clicking to select multiple files.)
X Use Sharing Wizard (Recommended)
When typing into list view (Automatically put the cursor in the search box when you start typing. This can be
useful if you don't often browse for files by typing the name of a file.)

X Automatically type into the Search Box

Select the typed items in the view.

You can click and unclick anytime you want. You can also click to restore the defaults.
Don’t be afraid to play with the options and see if you like them. Once you are finished clicking OK or Apply
puts your choices into effect.

To change the type of file that a folder can be optimized for, right-click the folder, click Properties, click the
Customize tab, click a file type in the Optimize this folder for list, and then click OK. This will not work if you are
in the Library. You can do the same thing while in the Organize pane by clicking on Properties. For example,
the My Pictures folder is optimized for picture files. If you open this folder and change the view to Large Icons,
you can apply the Large Icons view to every folder that's optimized for pictures. | gave a tip in my September
2014 tip column about changing icons while in the Customize mode, but will repeat it here to make it all
inclusive with the above suggestions.

Customize Your Folders

You can customize your folders to go from a plain folder icon to something that can represent what is inside the
folder. It used to be easier, but now you have to go to Computers and click on the C: drive, then go to users
and then documents. Right click on any folder and click Options and then click on Customize.

A new pane opens up with lots of icons. Select the one you want, click Apply and then OK. The icon will now
replace the old basic vanilla folder icon. If you don’t like the icon go back and click “restore original icon.” You
can also select “choose a file to show as the icon.”

Check the box next to "Choose A Background Picture" and click NEXT. From here you can choose from many
different backgrounds, or pick one that you have stashed on your computer somewhere. You can also change
the color of the text.

What is “hing"? https://security.intuit.com/phishing.html
The three | will discuss now are Phishing, Wishing and Vishing.

Most of us are now aware of Phishing. Phishing was and may still be the most commonly exploited threat
currently harassing internet users. This was considered a form of e-mail scamming where someone falsely
claims to be a legitimate business in an attempt to entice a victim into giving up personal information that will
be used for identity theft. This scam sends out an e-mail that looks like it comes from a legitimate business and
proceeds to ask you for personnel information. If you fall for it you can be seriously financially damaged. If you
receive such an e-mail, and wonder if it is legitimate, do not just click on the link in the message. Close out the
e-mail and sign in to the business by typing the URL you usually use to sign in.
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Now take everything you have just read, and apply it to text messaging. If you follow through on a looks-like-
the-real-thing text message, you have now become a victim of smishing. Smishing has been around for a
couple of years, but with the sudden proliferation and use of smart phones, attackers have gotten a little more
sly and a lot better at what they do. What can | say. If it appears correct, still don’t respond. Go to the site or
phone number you know, and ask. Most people have not heard of smishing yet and tend to trust text messages
more than e-mail, thus they respond and become immediate victims. Here are some tips to help protect you if
you own a smart phone:

First, get a reliable anti-virus program. Look for ones that have great reviews and solid recommendations.
Smart phones are like hand-held computers, and if you have an Apple iPhone or an Android phone, you have a
handheld computer with a real operating system. And what is the first thing you do after you have installed
Windows, Linux, or Apple on your computer? Why, put in an anti-virus program, of course. At the September
general meeting we had an informative lecture on Avast. Avast has a mobile phone app. You can download
and install.

And just in case one slips by don’t click on it and don’t call the number. Be sure of the number, and if you don’t
know it, don’t respond. In fact even if you think you know who it is, be prudent and be careful about calling the
number they instruct you to call.

Finally, we now come to vishing. Basically, vishing (derived from a combination of “voice” and “phishing.”)
has the same intent that phishing (and smishing) does, but it takes the form of landline phones to try and scam
you into revealing personal information such as your credit card number, your social security number, your
bank account number, your PIN number, etc. You know the calls you get that display an unknown number on
your caller ID? They can be from any area code, an 800 number, whatever. And they can be a source of a
vishing attempt.

Bottom line do not give out information unless you have initiated the call, and additionally, although it can be
hard, try not to have too much really personal information stored on your phone. And last tip, make sure you
have strong passwords for your financial accounts. Usually a strong password consists of six to eight
characters including upper case, lower case, numbers and other type of characters.

The Tip Corner — September 2014

By Bill Sheff, Lehigh Valley Computer Group, Pennsylvania
September 2014 issue, The LVCG Journal

www.lvcg.org

nsheff (at)aol.com

File Extensions

We all know that file extensions tell us what program can be used to open up a specific type of file. In Windows
Explorer some of you might notice that files are listed without the file extension. This is usually the default.
However in today’s world it might be a good idea to see what the file extension is which could help in
determining whether or not some files might be malicious. The easiest way to show file extensions on all files is
to go to Control Panel>Folder Options and click on View at the top of the window that opened. Scroll down to
where you see “Hide Extensions for known file types” and unclick the box to the left. This will now show all file
extensions. While there you might want to investigate the many other options available such as showing all
hidden system files that are usually hidden from view. Just clear the Hide protected operating system files
check box, and then click OK.
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Customize Your Folders

You can customize your folders to go from a plain folder icon to something that can represent what is inside the
folder. It used to be easier, but now you have to go to Computers and click on the C: drive, then go to users
and then documents. Right click on any folder and click Options and then click on Customize. A new pane
opens up with lots of icons. Select the one you want, click Apply and then OK. The icon will now replace the old
basic vanilla folder icon. If you don’t like the icon go back and click “restore original icon.” You can also select
“choose a file to show as the icon.”

Check the box next to "Choose A Background Picture" and click NEXT. From here you can choose from many
different backgrounds, or pick one that you have stashed on your computer somewhere. You can also change
the color of the text.

Display

If you click on Display in the Control Panel you can change the look of your computer; altering colors, fonts,
backgrounds, screen savers, etc. And if you want to check what's going on inside of a file or program just click
"Properties." You can do this by right clicking a file and select Properties from the menu, or you can hold down
your ALT key and doubling clicking the file.

What Does the Print Screen button do?

If you hold down Ctrl + Print Scrn keys you capture your entire screen. To capture a copy of only the open
window, hold down the Alt + Print Scrn keys. Although you do not see anything happen, the picture is now on
your Windows Clipboard, and you can paste it into any program that will allow you to view a picture. There are
also a lot of free screen capture programs. | use Gadwin Print Screen 4.7. It allows you to drag a diagonal on
the screen so you can copy just what you want. But another one is ScreenHunter 5 and it is also free. They
both take the pain out of grabbing screen captures and makes it easy to determine the area of the screen you
want to capture. You can then save to BMP or JPG format. Hotkeys are also available.

Another Way to View the Contents of the C: drive
On your keyboard, hit WINDOWS KEY + R. No Windows key? Get a new computer — Joke. Just click on Start
and in the text area type a backslash, (\ ), and hit enter.

Searching Files
You know that the FIND ultility allows you to search for files on your computer. But you can also search the
inside of your files to search for text.

This option was hidden in Windows 95 but is visible in Windows 98 and above. Just click on Find>Files or
Folders. In the text area labeled "Containing Text" type the text you're looking for.

Taskbar and START Menu
Right click on your taskbar and choose PROPERTIES. You can adjust many items on the Taskbar or Start
menus or Toolbars. Changing the size of icons and many other options are available.

Restart Your System Without Rebooting

To restart Windows without restarting your whole system, hold down your left SHIFT key and keep it pressed
throughout this process. Click START | SHUT DOWN. Choose "Restart." Click "OK." You may now release the
SHIFT key.

Registry Defrag 2.35

By this time most of us have been using CCleaner to clean up our computer and registry. But | don’t know if
CCleaner also closes up the gaps in the registry caused by scattered data. That's where Free Registry Defrag
comes in. It compacts and optimizes your Registry (though it doesn't remove invalid entries), and it even runs
on Windows Vista.
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Quick Startup 2.3

Lots of applications take the opportunity to load themselves when you start your PC, whether you want them to
or are even aware of them. Quick Startup shows you all those programs that start at startup and allows you to
disable the ones you don't really need to launch at startup.

Revo Uninstaller 1.5

After using Quick Startup 2.3, you may find apps on your system that you no longer need (or never wanted in
the first place). Revo Uninstaller goes beyond what Windows does with its Add/Remove Programs function,
cleaning up any remnants of a removed app (like Registry entries) that Windows might otherwise miss. It also
gathers files related to broken applications so you can clean them off your system.

What Is Under the Hood

Two programs that can help you see what your computer is all about are Belarc Advisor 7.2 and CPU-Z 1.43.
Belarc Advisor offers PC users the convenience of a full-system scan and a handy hardware and software
diagnostic report. It identifies the components in your PC—CPU, motherboard, RAM, hard drives, etc.—and
detects weaknesses in your system's security. Advisor can also tell if you have Windows vulnerabilities that
require running a patch, whether your antivirus software is up to date, and which Microsoft hotfixes your
system is missing. It will then create an HTML file of its report so you can easily view it in your Web browser.

CPU-Z can also tell you everything about your PC's core components, from basic specs like processor name
and RAM amount to overclocking essentials such as clock multiplier and voltage settings. If you want to find
out what's going on under the hood of your machine, CPU-Z can do it. Some people also call it a tweaker's
godsend

Recover Files 2

At some of our meetings we mentioned that there are various programs that will recover files even if the drive
has been reformatted. Well, this is not it. Bu if you have ever deleted a file from the recycle bin, Windows
Explorer or even a thumb drive by accident here is a free utility that will get it back for you. The caveat is that
you could not have rewritten over any part of the file. So when it happens recover right away before you start
filing stuff.

DoubleKiller 1.6.2

There are many programs that search out and list duplicate files. Over time it seems that duplicates just crop
into the computer. Invisible but there. The Windows search function doesn’t really work well, give DoubleKiller
1.6.2 a try. As its name suggests, the utility quickly finds doubles in your file library so you can decide whether
to delete the copy or not. DoubleKiller also lets you search by file type, which makes it easy if you just want to
clean up your MP3 collection.

Tips for Using Your Keyboard and Entering Text
By Jim Cerny, 2™ Vice President, Sarasota PCUG, FL
July 2014 issue, Sarasota Technology Monitor
WwWWw.Spcug.org

jimcerny123 (at) gmail.com

The keyboard is as old as the first typewriter and may very well be the oldest part of your computer. Although
computer innovations such as the mouse, voice-recognition, and the touch-screen have saved us from much
keyboard use, it still looks like the keyboard will be around for a good while yet. People buying touch-pads are
also buying keyboards for them! In the old days, believe it or not, the
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rules you followed for entering text into your computer were different in each program you used. Think of it —
each word processing program had different “rules” to learn in order to enter text into your computer. Today,
thankfully, all programs follow the same rules when using a keyboard. So if you are using your keyboard to
type an email, create a document, enter numbers in a spreadsheet, or fill in some data or text boxes on the
internet, you will be following the same rules. Rather than bore you with a list of these rules, | thought | would
just present a list of my most helpful keyboard tips and terms. Here they are:

Insertion point — the flashing vertical line or bar that indicates exactly where your next character will appear.
This bar automatically moves as you hit keys and enter the text. Do not hit any keys on your keyboard until you
know where the insertion point is. Note that if the text area is blank (that is if you are entering the first character
in the text area) the insertion point can only be placed at the beginning of the text area, that is, on the far left
and on the first line.

“I"-bar — a mouse cursor in an area where there is text or where text can be entered. Your mouse cursor will
automatically change from an arrow to an “I-bar” in a text area. You can move this I-bar with your mouse, place
it BETWEEN characters, click the left mouse button, and you will have placed your INSERTION POINT (see
above) where you click.

The arrow keys (up, down, left, right) will move the insertion point in that direction IF there is text there.

You cannot move the insertion point beyond the last character entered in a text area. You can, however, enter
blank characters, (by hitting the space bar), tab characters (by hitting the tab key), or go to a new line (by
hitting the enter key), and the insertion point will move accordingly (see “control characters” below). This can
be confusing. Some people wonder why they cannot just place the insertion point anywhere they want on a
blank page any start typing. Sorry, but word processors do not work that way. A word processor does NOT see
a blank page like a grid with positions everywhere on it for putting characters. If you think about it, a word
processor has the capability to reformat the text to allow all the text to be printed on pages with narrow or wide
margins. So the word processor sees only a single long string of text characters. Some of the characters in this
long string are control characters. What's a control character you ask? Well, let me tell you.

Control characters tell the printer (or the monitor screen) where to position for the next printed character on the
paper and within the margins. These characters are part of your document but are not printed on the paper.
For example, hitting the spacebar enters a space character and hitting the “tab” key enters a tab character.
Entering a “tab” character will usually enter a blank space on the line about a half an inch long. In other words,
hitting the “tab” key will move the insertion point one half inch to the right. Hitting the “Enter” key will go to a
new line. Because of these characters your text will look nice whether it is printed between narrow or wide
margins. The word processor formats the text to fit while obeying the control characters. The printed text will
flow from one line to the next whether the margins are wide or narrow (text wrapping). Think about it — would
you want to re-type your document every time the margins change? So a word processor will neatly flow the
text from one line to the next.

Holding down any key on the keyboard will quickly repeat that character. Be careful, | said “quickly”!

On laptops, you may wish to turn off the “mouse pad” while you are typing. On many laptop keyboards, the
mouse pad is positioned where the heel of your hand or bottom of your thumb may hit it and move your
insertion point to someplace else while you are trying to type your text. Most mouse pads on laptops have
different functions in different areas of the pad. For example, the right edge of a mouse pad may be used to
scroll up or down. Thus, the base of your hand may hit the pad and have confusing effects on the screen. To
turn off your mouse pad you will have to consult the instructions that came with your laptop. Most mouse pads
are turned off and on using a function key (one of the “F” keys at the top of your keyboard), perhaps in
combination with another key on your keyboard such as the “Ctrl” or “Alt” keys. Some laptop mouse pads are
automatically turned off when you plug in a mouse.

The “Insert” key, if pressed, will put you into the “overtype” mode in which you are REPLACING characters as
you type. Hit the Insert key again to turn this off. Many people find this “overtype” mode confusing, not noticing
what is happening until they see characters have been DELETED while they are typing new characters. | never
use the “insert” or “overtype” option.
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The “Caps Lock” key, as on the old typewriters, will enter all upper case letters. Hit the Caps Lock key again to
turn this option off. Notice if your keyboard has a light that comes on if a certain mode of typing has been
activated. For example, when you hit the “Caps Lock” key, a light on your keyboard may be turned on to
indicate that you are now in the “All caps” or all uppercase mode.

Almost all passwords are case sensitive. If there is an upper case (capital) letter in your password, then it
ALWAYS must be entered in upper case.

Save your work often. If you do not, you could lose everything you have entered before your last save. Most
emails may automatically save your work as a “draft” until you send your email. In Gmail, as | compose or write
my email, it is automatically saved every ten or fifteen seconds to my email draft folder. When | send the email,
the draft copy is automatically deleted and saved in the “sent mail” folder. Check your email program’s “help”
instructions to understand about auto-saving your email as you type.

If your keyboard is not working, first check to make sure it is properly connected. If you have a wireless
keyboard, make sure it is turned on and that the batteries are good.

Keyboards come in many styles and types (no pun intended), so find one that is comfortable for you. | even
have a rubber keyboard that can be rolled up for easy storage or transport, but it certainly does not feel
comfortable to use.

By the way, Windows 7 comes with “speech recognition” which you can try if you like. | gave it a try and found
that it took some getting used to. It is nice to know it is there if you need it, but | went back to my keyboard — |
guess | am just that “type” of guy.

There are many other keyboard tips and tricks. The keyboard will allow you to enter “shortcuts” or menu
commands for many software programs. Check the “help” for each program you use to learn what keyboard
commands are available. No matter what “type” of person you are, there are always keys to help.

Who Controls the Internet?

http://www.govtech.com/wireless/Who-Controls-the-Internet-Part-One.html
http://www.govtech.com/wireless/Who-Controls-the-Internet-Part-Two.html
http://www.govtech.com/wireless/Who-Controls-the-Internet-Part-Three.html Leo Laporte - Tech Guy
Labs, http://techguylabs.com, http://techguylabs.com/products

Leo’s radio stations, http://techguylabs.com/stations#zoom=3&lat=39.63954&lon=-95.97656&layers=TB
http:/tunein.com/radio/options/The-Tech-Guy-p49718/

Backup and Recovery, http://ftechguylabs.com/topics/backup-and-recovery

Episode 1156 http://techguylabs.com/episodes/1156, 2:38:27 - hours, minutes, seconds

Elon Musk wants to spend $10 billion to put the internet in space, how to make your router work better, find
out how much data individual apps on the iPhone are using, how to calibrate your HDTV at home, and more of
your calls. Topics Photography and Video, Mobile Phones, Home Theater, Media, Hardware, Internet and
Web, Software, Networking -

Samsung Galaxy S6 Edge smartphone

Samsung revealed the Galaxy S6 and the Galaxy S6 Edge this week at Mobile World Congress in Barcelona.
The Galaxy S6 Edge features a new dual-edge display that curves on both edges of the phone. It's a 5.1"
Quad HD Super AMOLED screen with a resolution of 2560x1440 and 577 pixels per inch.

The camera of the Galaxy S6 Edge is 16MP, takes Auto HDR pictures, and can capture 4K video. It's also
faster to activate the camera, at just 0.7 seconds. The selfie camera on the front is 5SMP and has a wider 120
degree angle.

Samsung's new Smartphone features a 64-bit, octa-core processor. It no longer features an SD card slot, but
internal storage options range from 32GB to 128GB. The Samsung Galaxy S6 and Galaxy S6 Edge will be
available in April.
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Learn more about the Samsung Galaxy S6 and Galaxy S6 Edge (Official Site)
http://techguylabs.com/topics/mobile-phones

iPhone, how can | save text messages?
http://techguylabs.com/episodes/1167/how-can-i-save-text-messages

Microsoft now says Windows computers could have a ‘FREAK’ attack
http://www.digitaltrends.com/computing/microsoft-now-says-windows-computers-freak-attack

“FREAK” is short for Factoring attack on RSA-EXPORT Keys, according to ArsTechnica.com. The attacks
are possible when a vulnerable user logs onto a vulnerable HTTPS-protected website using a device prone to
being compromised. In this case, Windows computers fall into that category.

PCs and laptops aren’t the only products that could have a FREAK attack, however. Prior to the announcement
from Microsoft, everything from iPhones to Android devices was thought to be susceptible to an attack.

During a FREAK attack, hackers watch the traffic passing between browsers and vulnerable servers. They can
then inject malicious packets into the flow that cause the two parties to use a weak, 512-bit encryption key.
With this weakness in place, hackers can collect some of the exchanged information using cloud-based
computing.

Security researchers have found that out of 14 million HTTPS-protected websites, about 36 percent of them
supported weak cipher, rendering them vulnerable to a FREAK attack. They note that companies including
Google, Microsoft, and Apple have been slow to develop patches, which hints that FREAK attacks pose a low
threat at the moment. So don’'t FREAK out just yet.

How to protect your Wmdows machine agalnst the FREAK hack attack [ Don‘t web surf bad S|tes' ]

freak hack-attack. htmI Microsoft is working on a patch that will solve the problem. Until then, though,
if you're willing to get your hands dirty, (etc.) ...or wait for a Microsoft fix - unknown time frame.
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Short Circuits....zzzt! An Equinox

Earth Axis

Arctic Clrcla

Troplke of Cancor

Equator

Sun ravs

Troghc of Capricomm

Antarctic Cirche

“During an equinox, the Earth's North and South poles are not tilted toward or away from the
Sun, and the duration of daylight is theoretically the same at all points on Earth's surface.” -
Wikipedia

Spring Fever

Four high school boys afflicted with spring fever skipped morning classes. After lunch they reported
to the teacher that they had a flat tire. Much to their relief she smiled and said, "Well, you missed a
test today so take seats apart from one another and take out a piece of paper." Still smiling, she
waited for them to sit down. Then she said: "First Question: Which tire was flat?"

May your glass be ever full. May the roof over your head be always strong.
And may you be in heaven half an hour before the devil knows you’re dead.
Drink green beer on St Patrick’s Day! It counts as a vegetable!

Spring Vegetable Joke
Q: What's Michelle Obamas favorite vegetable? A: Barackoli (like broccoli)

Q: How is a man like the weather? A: Nothing can be done to change either one of them.
Q: What did the tornado say to the sports car? A: Want to go for a spin!
Q: What kind of shorts to clouds wear? A: Thunderwear!

Q: What's a tornado's favorite game? A: Twister!

Q: What bow can't be tied? A: A rainbow!

Q: What falls but never hits the ground? A: The temperature!

Q: Easter Bunny’s Chinese Restaurant order?  A: Hop Suey!

Q: What do you call a rabbit with fleas? A: Bugs Bunny

Q: What did the spider do on the computer? A: Made a website!

Q: What did the computer do at lunchtime? A: Had a byte!

Q: What does a baby computer call his dad? A: Datal

Q: Why did the computer keep sneezing? A: It had a virus!

Q: What is a computer virus? A: A terminal illness!

Q

: Why was the computer cold? A: It left it's Windows open!
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MEMBERSHIP DUES

The Official Policy of the Phoenix PC Users Group is that we
do not condone software piracy in any form.

2015 DUES $36, prorated
Example - $9 for 3 months

Phoenix PC Users Group Membership Application

First: (Print Legibly) Initial: Last:

Address:

City, State: Zip

Code:

Home or Cell Phone: Work Phone: Ext:

Please note: We DO-NQOT share phone numbers outside the club, and will generally only
use your phone information, if we cannot contact you in a timely fashion, via e-mail, or
the club web-site.

Receive Electronic PDF newsletter in place of a printed one: Yes No

E-mail address:

(Print Legibly)

Signature Date / /
Release my address to vendors ?  Yes No Note: Phone numbers will not be
listed.

May the club share your e-mail address with other members only? Yes No

With club approved vendors? Yes No

Mail this completed form with payment to:

Phoenix PC Users Group
PO Box 45451
Phoenix, AZ 85064-5451
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apcuq
The Best Accessory
Users Group: for your PC!

AZACC.com member
Our Web address: www.phoenixpcug.org also see

www.phoenixpcug.org/newsletters

The Newsletter of the Phoenix Personal Computer Users Group
"Users helping users to understand computers”.

PHOENIX PC USERS GROUP
PO Box 45451 STAMP
PHOENIX, AZ 85064—5451

PLEASE NOTE - OUR NEW ADDRESS




